
9 

BAB 2  

LANDASAN TEORETIS 

2.1 Kajian Teori 

2.1.1 Pengembangan  

Menurut Kamus Besar Bahasa Indonesia (KBBI), pengembangan adalah proses, 

metode, atau tindakan untuk mengembangkan sesuatu atau tindakan memperluas, 

memperbesar, dan meningkatkan suatu hal atau produk.  Pengembangan merupakan 

suatu proses atau serangkaian kegiatan yang bertujuan untuk menciptakan, memperbaiki, 

atau meningkatkan suatu produk, sistem atau metode sehingga menjadi lebih baik, efisien 

dan lebih efektif. Gall & Brog menjelaskan penelitian pengembangan adalah suatu proses 

mengembangkan dan memvalidasi suatu produk. Pengembangan merupakan suatu 

proses yang melibatkan langkah-langkah untuk merancang, mengembangkan, serta 

memvalidasi atau menguji produk yang dikembangkan, guna memastikan produk 

tersebut efektif dan sesuai dengan tujuan yang telah ditetapkan. Penelitian 

pengembangan merupakan proses menghasilkan suatu produk melalui analisis 

kebutuhan dan menguji keefektifan produk yang dihasilkan sehingga berfungsi dengan 

baik di masyarakat (Sugiyono, 2015).  Penelitian dan pengembangan merupakan proses 

merancang serta mengembangkan media melalui tahapan penelitian, sehingga 

menghasilkan media yang layak dan valid untuk digunakan dalam kegiatan 

pembelajaran. (Batubara, 2020). Proses ini bertujuan untuk menghasilkan media yang 

efektif, layak, dan valid untuk digunakan dalam kegiatan pembelajaran. Dengan kata 

lain, penelitian dan pengembangan berfokus pada menciptakan media pembelajaran yang 

dapat dipertanggungjawabkan kualitasnya agar dapat digunakan secara optimal dalam 

pendidikan. Berdasarkan hasil analisis sistematis dapat disimpulkan bahwa 

Pengembangan adalah proses perancangan, pembuatan, dan penyempurnaan produk 

berdasarkan standar yang telah ditetapkan.  

Terdapat beberapa kelebihan dalam penelitian & pengembangan menurut 

(Helaluddin, Tulak, & Rante, 2020)  jika dibandingkan dengan penelitian lain, yaitu: 

(1) Mampu Mampu memenuhi kebutuhan nyata dan mendesak dari peserta didik dan 

pendidik (real needs in the here-and-now) dengan mengembangkan solusi atas suatu 
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permasalahan, sehingga menghasilkan pengetahuan yang berguna untuk masa 

sekarang dan masa depan. 

(2) Dapat menghasilkan produk atau model dengan tingkat validasi tinggi karena telah 

melewati serangkaian uji coba di lapangan serta penilaian dari para ahli. 

(3) Memulai proses inovasi produk atau model secara berkelanjutan agar tercipta produk 

atau model yang selalu relevan dengan perkembangan zaman. 

(4) Penelitian dan pengembangan berperan sebagai penghubung antara penelitian teoritis 

dan penelitian lapangan. Jenis penelitian ini memiliki keunggulan dibandingkan 

dengan penelitian konvensional seperti eksperimen, survei, dan analisis korelasional. 

Penelitian dan pengembangan lebih mengedepankan aspek deskriptif serta 

kepraktisan, sementara penelitian konvensional hanya berfokus pada pengetahuan 

deskriptif saja (Akker dalam Helaluddin, 2020). Aspek deskriptif yang praktis yang 

dimaksud yaitu bagaimana produk atau media dapat diterapkan secara efektif dalam 

konteks nyata, sementara penelitian konvensional lebih fokus pada pengumpulan dan 

analisis pengetahuan deskriptif tanpa memperhatikan aspek implementasinya. Dengan 

demikian, penelitian dan pengembangan memberikan kontribusi praktis sekaligus 

kontribusi ilmiah secara bersamaan. Dalam pengembangan suatu produk, diperlukan 

suatu model untuk memahami pelaksanaan suatu proses supaya lebih efektif dan efisien. 

Menurut Sugiyono (2015) dalam penelitian terdapat beberapa model pengembangan 

media pembelajaran. Setiap model pengembangan terdapat tahapan pengembangan yang 

beragam.  

Menurut Branch (2009)  “ADDIE is an acronym for Analyze, Design, Develop, 

Implement, and Evaluate”, yang merupakan langkah utama dalam proses pengembangan 

dan desain itruksional. ADDIE adalah konsep pengembangan produk yang mencakup 

beberapa aspek seperti desain instruksional, keahlian materi pembelajaran, serta 

identifikasi dan penyelesaian masalah. Pengembangan pada setiap tahapan saling terkait 

satu sama lain. Adapun tahapan model ADDIE meliputi Analyze, Design, Develop, 

Implement dan Evaluate. Gambar tahapan model ADDIE dapat dilihat pada gambar 

berikut ini. 
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Gambar 2.1. Model ADDIE (Waruwu, 2024) 

Pengembangan pada setiap tahapan saling terkait satu sama lain. Berikut pembahasan 

masing masing tahapan:  

(1) Analyze 

Tahap ini merupakan analisis terkait kebutuhan Pengembangan produk atau model 

serta penilaian kelayakan produk dimulai dari identifikasi masalah pada produk yang 

sudah ada sebelumnya. 

(2) Design 

Tahap ini bertujuan untuk merancang produk yang akan dikembangkan. Desain 

produk masih dalam bentuk konsep dan menjadi landasan untuk proses 

pengembangan selanjutnya. 

(3) Development 

Tahap ini adalah tahap pengembangan produk yang siap diterapkan atau diuji coba. 

Pada tahap ini juga disusun instrumen untuk mengukur kinerja produk. 

(4) Implementation 

Tahap ini merupakan tahap implementasi produk yang telah dikembangkan. Pada 

tahap ini, peneliti memperoleh masukan atau umpan balik terkait penggunaan produk 

tersebut. 

 diterapkan. 

(5) Evaluation 

Tahap ini adalah tahap evaluasi produk atau model yang dikembangkan, di mana 

peneliti menerima umpan balik dari pengguna. 
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Dalam penelitian ini peneliti menggunakan model yang telah dioptimalkan oleh 

Branch (2009) yaitu ADDIE (Analysis, Design, Development, Implementation and 

Evaluation). Model ADDIE sering digunakan sebagai alternatif untuk pengembangan 

produk atau model dalam pembelajaran. Model ADDIE memiliki keunggulan dalam 

fleksibilitasnya, memungkinkan penyesuaian dengan berbagai jenis proyek 

pengembangan media pembelajaran. Proses iteratif yang dilakukan melalui evaluasi 

berkelanjutan juga memungkinkan perbaikan produk yang lebih optimal. Struktur 

langkah yang jelas memudahkan pengembang mengikuti tahapan dari analisis hingga 

evaluasi, sementara fokus pada analisis kebutuhan memastikan media yang 

dikembangkan sesuai dengan audiens sasaran 

2.1.2 Media Pembelajaran Interaktif 

Kemajuan ilmu pengetahuan dan teknologi yang begitu cepat telah memberikan 

pengaruh besar terhadap bidang pendidikan. Oleh karena itu, para pendidik diharapkan 

mampu menciptakan inovasi pembelajaran yang memanfaatkan teknologi terkini guna 

meningkatkan minat belajar peserta didik. Salah satu solusi yang bisa diterapkan adalah 

dengan memanfaatkan media pembelajaran interaktif. Media pembelajaran merupakan 

alat, metode, atau sarana yang digunakan dalam proses belajar-mengajar yang 

memungkinkan terjadinya interaksi dua arah antara pendidik dan peserta didik, sehingga 

peserta didik tidak hanya menjadi penerima informasi secara pasif, tetapi juga dapat 

berpartisipasi aktif dalam kegiatan pembelajaran. Hal ini sejalan dengan pendapat 

Batubara (2020) yang menyatakan bahwa media pembelajaran merupakan segala jenis 

objek, alat, bahan, dan saluran yang dimanfaatkan untuk mendukung kelancaran proses 

pembelajaran. Media pembelajaran adalah suatu wadah yang digunakan untuk 

menyampaikan suatu informasidalam proses pembelajaran sehingga informasi yang 

disampaikan dapat ditrerima dema dengan mudah sesuai dengan tujuan pembelajaran 

(Handayani & Rahayu, 2020). 

Media pembelajaran menekankan perannya sebagai sarana pemberian informasi 

atau pesan selama proses pembelajaran guna menciptakan kondisi yang mendorong 

seseorang untuk belajar (Riana, 2012). Menurut Haryadi dan Widodo (dalam Batubara, 

2020) media pembelajaran adalah sarana yang digunakan dalam proses pembelajaran, 

baik yang bersifat tra disional maupun bersifat modern. Media pembelajaran merupakan 
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alat bantu, baik yang bersifat fisik maupun nonfisik, digunakan secara sengaja sebagai 

perantara antara pendidik dan peserta didik guna mempermudah pemahaman materi 

pembelajaran agar berlangsung lebih efektif dan efisie (Amka, 2018). Dengan demikian, 

materi pembelajaran dapat lebih mudah dan cepat dipahami secara menyeluruh oleh 

peserta didik serta mampu meningkatkan minat mereka untuk melanjutkan proses 

belajar. 

Berdasarkan berbagai pendapat para ahli, media pembelajaran dapat disimpulkan 

sebagai sarana yang digunakan untuk mendukung proses pembelajaran. Media ini 

berfungsi sebagai perantara dalam penyampaian informasi atau pesan pembelajaran, baik 

melalui alat fisik maupun non-fisik, dengan tujuan menciptakan kondisi yang mendorong 

peserta didik untuk belajar. Media pembelajaran memiliki peran penting dalam 

mempermudah pemahaman materi, meningkatkan efisiensi proses belajar, serta menarik 

minat peserta didik untuk lebih mendalami materi pembelajaran. Hal ini mencakup 

penggunaan teknologi modern maupun alat tradisional sesuai dengan kebutuhan 

pembelajaran. 

Istilah “interaktif”mensyaratkan adanya komunikasi dua arah yang jelas berbeda 

dari belajar tatap muka biasanya, media interaktif ini disertai dengan kontrol yang dapat 

dijalankan oleh pengguna, memungkinkan mereka untuk menentukan sendiri langkah 

atau proses yang diinginkan selanjutny (Watri, Gimin, & Suarman, 2023)  Hal ini 

berbeda dari pembelajaran tatap muka yang biasanya bersifat satu arah, di mana pendidik 

menyampaikan materi secara langsung tanpa melibatkan partisipasi aktif dari peserta 

didik. Dengan media interaktif, proses pembelajaran lebih fleksibel dan dinamis, 

memberikan ruang bagi peserta didik untuk mengontrol jalannya pembelajaran. Media 

pembelajaran interaktif merupakan sebuah media yang digunakan dalam proses 

pembelajaran sehingga memungkinkan terjadinya interaksi antara pengguna dalam hal 

ini peserta didik dengan konten pembelajaran, berupa media,  video, simulasi, ataupun 

perangkat lunak lainnya yang dirancang untuk meningkatkan keterlibatan peserta didik 

selama proses pembelajaran (Handayani & Rahayu, 2020). Media pembelajaran 

interaktif adalah sarana yang memungkinkan terjadinya interaksi timbal balik antara 

peserta didik dan konten pembelajaran. Dengan memanfaatkan berbagai fitur seperti 

video, simulasi, dan perangkat lunak, media ini mendukung komunikasi dua arah yang 

meningkatkan keterlibatan aktif peserta didik. Hal ini menjadikan media pembelajaran 
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interaktif sebagai alat yang efektif dalam menciptakan pengalaman belajar yang lebih 

menarik, partisipatif, dan berorientasi pada pencapaian tujuan pembelajaran. 

Media pembelajaran interaktif memiliki beberapa karakteristik sehingga 

membuat media pembelajaran interaktif lebih menarik digunakan dalam pembelajaran. 

Salah satunya yang dikemukakan oleh Munir (dalam Setyowati, Hidayati, & Hermawan, 

2020) yaitu: (1) media pembelajaran memiliki lebih dari satu media yang konvergen, 

salah satu contohnya dapat mengkombinasikan unsur visual dan audio; (2) media 

pembelajaran bersifat interaktif, yaitu media dapat mengakomodasi respons peserta 

didik; (3) media pembelajaran bersifat mandiri, artinya media tersebut memudahkan 

peserta didik untuk belajar secara independen tanpa memerlukan bimbingan dari orang 

lain. Media pembelajaran interaktif adalah jenis media yang memungkinkan adanya 

interaksi antara pengguna dan media, di mana terjadi saling pengaruh, aksi, dan reaksi 

yang membantu dalam penyampaian materi pembelajaran. (Yanto, 2019). Dengan kata 

lain, media pembelajaran interaktif dapat diartikan sebagai alat perantara yang digunakan 

pendidik untuk menyampaikan materi kepada peserta didik, dimana penggunaannya 

menciptakan interaksi antara peserta didik dan media. Interaksi ini terjadi secara saling 

terkait, dimana peserta didik dan media saling memberikan aksi dan reaksi satu sama 

lain. 

Sebagai sarana atau alat bantu dalam proses pembelajaran, media pembelajaran 

interaktif memiliki kelebihan dan kekurangan. Seperti yang dikemukakan Munadi 

(dalam Handayani et.al, 2020) yaitu sebagai berikut:  

(1) Kelebihan media pembelajaran  interaktif  

(a) media   dirancang atau diprogram agar dapat digunakan oleh peserta didik secara 

mandiri (belajar secara individual). 

(b) Memberikan suasana pembelajaran yang hangat dan mendukung secara persoal  

(c) dapat meningkatkan motivasi belajar bagi peserta didik 

(d) memberikan umpan balik atau respons yang baik 

(e) menjadikan pembelajaran lebih mandiri 

(2) Kekurangan media pembelajaran interaktif  

(a) Memerlukan tenaga atau tim yang profesional  

(b) Memerlukan waktuu yang cukup lama dan  

(c) Memerlukan biaya yang cukup besar 
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Berdasarkan analisis sintesis, dapat disimpulkan bahwa media pembelajaran 

interaktif adalah sarana pembelajaran yang dirancang untuk menciptakan komunikasi 

dua arah antara peserta didik dan konten pembelajaran. Media ini memadukan berbagai 

elemen seperti visual, audio, video, atau simulasi, yang memungkinkan interaksi 

langsung, memberikan kemudahan belajar mandiri, dan meningkatkan keterlibatan aktif 

peserta didik. Dengan karakteristiknya yang menarik dan fleksibel, media pembelajaran 

interaktif efektif mendukung proses pembelajaran yang lebih efisien dan menarik 

2.1.3 Berbasis Android  

Di era teknologi saat ini, penggunaan media berbasis Android dalam proses 

pembelajaran berkembang pesat hal ini terjadi karena Android memberikan kemudahan 

akses, interaktivitas, serta fleksibilitas yang mendukung pengalaman belajar yang lebih 

efektif. Android merupakan platform  pemrograman untuk ponsel pintar, tablet, dan 

perngkat lainnya yang dikembangkan oleh Google (Musliadi & Herlinah, 2019). Android 

merupakan sistem operasi berbasis linux yang dirancang untuk perangkat bergerak layar 

sentuh dari telepon pintar dan tablet (Firly dalam Dewi, 2021). Android merupakan 

sebuah sistem operasi untuk perangkat mobile berbasis linux yang mencakup sistem 

operasi, middleware, dan aplikasi ( Kuswanto & Radiansah, 2018).  Android merupakan 

sistem operasi untuk telepon seluler berbasis linux yang menyediakan platform  terbuka 

bagi para pengembang untuk menciptakan aplikasi mereka sendiri (Prabowo, Wijayanto, 

Yudanto, & Nugroho, 2021). Dari keempat pendapat tersebut dikatakan bahwa Android 

merupakan sistem operasi berbasis linux yang dirancang untuk perangkat bergerak, 

seperti telepon pintar dan tablet. Selain berfungsi sebagai sistem operasi, Android juga 

mencakup middleware dan aplikasi, yang membentuk ekosistem yang mendukung 

pengembangan aplikasi. Ketiga pendapat tersebut menyatakan bahwa Android 

menyediakan platform  terbuka bagi pengembang untuk menciptakan aplikasi mereka, 

menjadikannya sistem operasi yang fleksibel dan dapat dikembangkan sesuai kebutuhan 

pengguna. Dengan adanya platform yang disediakan oleh Android, para pengembang 

dapat dengan mudah berkreasi dalam membuat aplikasi sesuai kebutuhan masing-

masing. Berdasarkan hasil analisis sintesis, dapat disimpulkan bahwa Android adalah 

sistem operasi berbasis Linux yang dirancang untuk perangkat seluler dengan layar 
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sentuh, mencakup sistem operasi, middleware, dan aplikasi, serta bersifat open source 

yang memberikan kebebasan dalam pengembangan aplikasi. 

Android memang dikembangkan untuk digunakan pada perangkat mobile 

berlayar sentuh seperti smartphone dan tablet, sehingga sistem operasi ini dapat 

menyesuaikan dengan berbagai spesifikasi, mulai dari kelas low-end hingga high-end 

(Prabowo et al., 2021). Perkembangan sistem Android meningkat cukup  tajam. Android 

merupakan sistem operasi yang terbuka dimana pihak Google memperbolehkan dan 

membebaskan setiap pihak untuk dapat mengembangkan sistem operasi tersebut. Sistem 

operasi Android terdiri dari beberapa versi. Setiap versi Android terbaru memiliki nama 

unik tersendiri dan memiliki berbagai macam kelebihan mulai dari tampilan hingga 

optimasi kemanan. Sistem operasi Android pertama kali rilis pada tahun 2008 dan telah 

berkembang hingga saat ini. Beberapa sistem operasi Android yang sudah dirilis dari 

diantaranya disajikan dalam tabel 2.1. berikut. 

Tabel 2.1. Versi Android 

No Versi Android Kode Nama 

1 Android 1.0 Alpha 

2 Android 1.1 Beta 

3 Android 1.5 Cupcake 

4 Android 1.6 Donut 

5 Android 2.0 – 2.1 Eclair 

6 Android 2.2 Froyo 

7 Android 2.3 Gingerbread 

8 Android 3.0 – 3.2 Honeycomb 

9 Android 4.0 Ice Cream Sandwich 

10 Android 4.1 – 4.3 Jelly Bean 

11 Android 4.4 Kitkat 

12 Android 5.0 Lollipop 

13 Android 6.0 Marshmallow 

14 Android 7.0 – 7.1 Nougat 

15 Android 8.0 – 8.1 Oreo 

16 Android 9 Pie 

17 Android 10 Android Q 

18 Android 11 Red Velvet Cake 

19 Android 12 Snow Cone 

20 Android13 Tiramisu 

21 Android 14 Upside Down Cake 

22 Android 15 Vanilla Ice Cream 

Referensi: bhinneka.com 

Berdasarkan daftar versi Android tersebut, secara umum Articulate Storylin 3 

mendukung perangkat dengan versi Android 5.0 (Lollipop) ke atas. Media pembelajaran 

yang dihasilkan oleh Articulate storyline 3 menggunakan HTML 5 sebagai format output 
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utama. Android 5.0 (Lollipop) adalah versi pertama yang menawarkan dukungan penuh 

untuk HTML5 melalui browser modern seperti Google Chrome. Meskipun dapat 

berjalan di Android 5.0, pengalaman terbaik akan diperoleh pada perangkat dengan versi 

6.0 (Marsmallow) atau lebih tinggi, karena performa dan stabilitasnya yang lebih baik 

dalam menjalankan konten berbasis HTML5, terutama melalui browser modern seperti 

Google Chrome. Selain itu, versi Android yang lebih baru juga menawarkan dukungan 

yang lebih baik untuk akses offline, jika media pembelajaran dikonversi ke format yang 

dapat digunakan tanpa koneksi internet. Dengan demikian, Articulate storyline 3 

memberikan fleksibilitas dan efisiensi yang optimal untuk mendukung pembelajaran 

berbasis Android. 

Terdapat beberapa kelebihan dan kekurangan saat menggunakan Android sebagai 

media pembelajaran yang disebutkan oleh (Prabowo et al., 2021) sebagai berikut: 

(1) Kelebihan Android 

(a) User Friendly, artinya sistem Android sangat mudah untuk dijalankan dan tidak 

memakan waktu yang banyak untuk mempelajarinya. 

(b) Terdapat beragam notiifikasi yang bisa muncul seperti SMS, Email, Voice Dial, 

dan lainnya tetapi pengguna dapat mengatur notifikasi apa yang akan 

dimunculkan  

(c) Tampilan sistem Android cukup menarik dan tidak kalah baiknya dengan iOS 

(Apple).  

(d) Menggunakan sistem operasi dengan konsep open source yang memungkinkan 

pengguna untuk mengembangkan versi sistem Android mereka sendiri, sehingga 

tersedia beragam custom ROM yang dapat digunakan. 

(e) Menyediakan berbagai pilihan aplikasi menarik, mulai dari aplikasi gratis hingga 

berbayar, yang bisa diunduh melalui Google Playstore 

(2) Kekurangan Android 

(a) Pembaruan sistem yang kurang efisien. Android sering kali mendapatkan 

peningkatan versi yang ditawarkan kepada pengguna, namun proses pembaruan 

ini mengharuskan pengguna menunggu vendor perangkat masing-masing merilis 

pembaruan resmi terbaru.  

(b) Konsumsi baterai yang cepat habis. 
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(c) Sering mengalami keterlambatan atau lag, yang biasanya disebabkan oleh 

spesifikasi perangkat. 

2.1.4 Articulate storyline 3 

Articulate storyline 3 adalah perangkat lunak yang dapat digunakan untuk 

membuat konten pembelajaran dengan mengintegrasikan berbagai elemen seperti teks, 

gambar, audio, dan video, serta dilengkapi fitur-fitur interaktif seperti kuis, simulasi, atau 

animasi. Selain berbagai fitur aplikasinya, Articulate Storyline 3 juga mendukung 

pengimporan berbagai jenis file media seperti animasi (swf), video (flv), gambar, dan e-

book (pdf) yang dapat digunakan untuk mendukung proses pembelajaran. (Simanullang, 

2023). Articulate storyline 3 merupakan perangkat lunak yang diciptakan dan 

dikembangkan oleh Global Incorporation yang memungkinkan pengguna untuk 

membuat sebuah media pembelajaran interaktif dalam berbagai format (Somba et al., 

2024). Perangkat ini kompatibel dengan sistem operasi Windows, Android, dan iOS. 

Articulate Storyline 3 menyediakan fitur bagi pengguna untuk menambahkan berbagai 

objek, seperti gambar, video, dan konten web. Articulate Storyline 3 merupakan aplikasi 

pembuat media yang menawarkan banyak keunggulan. Software ini adalah alat e-

learning yang berfungsi untuk menciptakan multimedia pembelajaran interaktif, 

dilengkapi dengan berbagai tools, dan memiliki antarmuka yang mirip dengan 

PowerPoint (Saskia, Ajizah, & Hafizah, 2022). Berdasarkan analisis sintesis, dapat 

disimpulkan bahwa Articulate storyline 3 adalah perangkat lunak yang dapat digunakan 

untuk membuat materi pelajaran interaktif. Media ini dapat berupa aplikasi yang dapat 

dijalankan di berbagai perangkat, termasuk laptop, komputer, dan smartphone, serta 

dapat diakses secara bebas oleh pengguna kapan saja dan dari mana saja. Media ini juga 

dapat berupa teks, grafik, gambar, suara, animasi (swf), video (flv), dan e-book (pdf) 

dalam format web (HTML5). 

Articulate storyline 3 pembaharuan dari Articulate Storyline 2 yang diproduksi 

oleh perusahaan Articulate pada tahun 2017. Dibandingkan dengan versi sebelumnya, 

Articulate storyline 3 memiliki kemampuan yang lebih baik dan lebih menyeluruh. Untuk 

mengoperasikan perangkat lunak Articulate storyline 3 tidak diperlukan bahasa 

pemrograman. Hal ini menjadikan software Articulate storyline 3 mudah digunakan dan 

membantu desainer belajar dari tingkat pemula hingga ahli. Kelebihan program 
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Articulate Storyline 3 adalah memiliki smart brainware yang sederhana dengan prosedur 

tutorial interaktif melalui template yang bisa dipublikasikan secara offline maupun 

online, sehingga memudahkan pengguna dalam memformatnya menjadi web personal, 

CD, dokumen word processing, maupun Learning Management System (LMS). Dalam 

software Articulate Storyline terdapat empat fungsi utama yang sangat berguna untuk 

pembuatan media pembelajaran berbasis ICT, baik versi offline maupun online, yaitu: 

(1) Articulate Storyline Engage: digunakan untuk merancang materi pembelajaran yang 

interaktif. 

(2) Articulate Storyline Quiz Maker: digunakan untuk membuat berbagai jenis soal 

interaktif, terdiri dari 11 variasi seperti pilihan ganda, esai, mencocokkan/True False, 

dan lain-lain. 

(3) Articulate Storyline Presenter: berfungsi menggabungkan media pembelajaran 

interaktif yang dibuat dengan Articulate Storyline Engage dan soal-soal interaktif 

dari Articulate Storyline Quiz Maker. Software ini akan otomatis terintegrasi dengan 

PowerPoint setelah instalasi. 

(4) Articulate Storyline Video Encoder: digunakan untuk mengedit video yang ada dan 

mengubahnya menjadi video pembelajaran. 

Selain keempat fungsi tersebut, Articulate Storyline 3 juga memiliki beberapa 

keunggulan, antara lain: 

(1) Mudah digunakan, baik oleh pengguna yang berpengalaman maupun pemula. 

(2) Mendukung berbagai format file, seperti PowerPoint, Flash, video, dan lainnya. 

(3) Menyediakan fitur audio dan visual, memungkinkan pembuatan suara dan gambar 

langsung di dalam aplikasi. 

(4) Memiliki aplikasi pembuatan kuis tanpa perlu mengimpor file dari sumber lain. 

(5) Menyajikan konten yang interaktif sehingga lebih melibatkan peserta didik dalam 

proses pembelajaran. 

Salah satu kekurangan dari Salah satu kekurangan paling mencolok dari 

Articulate Storyline adalah harga lisensi software yang relatif mahal (kurniawan, 2020). 

Sebelum menggunakan aplikasi Articulate Storyline 3, terdapat beberapa persyaratan 

yang harus dipenuhi untuk instalasi aplikasi tersebut, yang dapat dilihat pada tabel 2.2. 

sebagai berikut. 
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Tabel 2.2. Syarat Penginstalan Aplikasi Articulate storyline 3 

Hardware Software 

1) CPU 2 GHz processor or higher (32-bit 

or 64-bit)  

2) Memori minimal 2 GB.  

3) Available disk space minimal 1 GB  

4) Display 1280 × 720 screen resolution or 

higher   

5) Multimedia sound card, microphone, 

webcam for recording naration and 

video 

1) Operasional sistem windows 7,8,10 (32-

bit atau 64-bit)  

2) Mac OS × 10.6.8  

3) Netframework minimal versi 4.5.2  

4) Visual++  

5) Adobe flash player minimal versi 10.3 

(Rohmah & Bukhori, 2020) 

Berikut adalah gambaran umum aplikasi Articulate storyline 3 dan fitur-fitur 

yang digunakan peneliti untuk membuat media pembelajaran interaktif yang ditampilkan 

di pada gambar dibawah ini.  

(1) Layar pertama yang muncul ketika meluncurkan aplikasi Articulate storyline 3 

setelah diinstal.  

 

Gambar 2.2 Tampilan Awal Membuka Articulate storyline 3 

 

(2) Menu Articulate storyline 3 muncul di sudut kiri atas layar saat aplikasi pertama kali 

ditampilkan seperti pada gambar 5. berikut ini. 
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Gambar 2.3. Tampilan Awal Menu Articulate storyline 3 

Beberapa pilihan menu pada tampilan awal Articulate storyline 3 meliputi :  

(a) New Project : untuk membuat sebuah proyek atau presentasi baru yang dalamnya 

terdapat lembar kerja kosong. 

(b) Record Screen: untuk merekam layar monitor saat proyek atau presentasi sedang 

berjalan.  

(c) Import: pada bagian import maka muncul lima opsi, opsi ini digunakan apabila 

ingin membuat sebuah proyek yang berasal dari power point, quizmaker, Engage, 

templat dari articulate storyline yang sudah dimiliki, pertanyaan dari file teks 

(.txt) atau Microsoft Excel. 

(d) Recent: untuk melihat daftar proyek atau presentasi yang sebelumnya sudah 

pernah dibuka. 

(e) Brows for more: untuk membuka proyek Articulate storyline 3 yang sebelumnya 

sudah pernah dibuat. 

(3) Pengerjaan proyek baru dapat dilakukan dengan menekan tombol “new project” 

maka tampilan halaman menu utama Articulate storyline 3 akan muncul. Pada 

halaman ini menyediakan lembar kerja kosong yang siap dirancang. 



22 

 

 

Gambar 2.4.  Tampilan Menu Utama Articulate storyline 3 

(4) Halaman kerja Articulate storyline 3 ditampilkan pada tampilan ini, di mana proyek 

dapat dibuat menggunakan fitur-fitur yang terdapat pada aplikasi Articulate storyline 

3 seperti berikut:  

(a) Pemilihan latar atau background 

Pemilihan latar yang telah disiapkan dapat dilakukan dengan mengklik tombol 

kiri mouse pada slide, kemudian memilih opsi format background, selanjutnya 

klik ikon picture > file, dan pilih latar yang sudah tersedia dari laptop atau 

komputer. 

 

Gambar 2.5. Tampilan format background 
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(b) Pemilihan jenis ukuran huruf 

Untuk menentukan jenis dan ukuran huruf, klik menu Home > pilih bagian Font, 

lalu tentukan jenis font dan ukuran yang diinginkan. 

 

Gambar 2.6. Tampilan pemilihan jenis ukuran huruf 

(c) Fitur untuk memasukan media 

Untuk dapat memasukan media seperti gambar, shape, caption, video, audio dan 

web dapat dilakukan dengan memilih menu Insert>pilih media yang ingin di 

masukan (gambar, video dll). Kemudian dapat memilih timeline untuk mengatur 

kapan gambar, video, ataupun yang lainnya muncul.  

 

Gambar 2.7.  Tampilan memasukan media 

(d) Pemilihan objek interaktif 

Untuk dapat membuat tombol interaktif pada media dapat dilakukan dengan 

mengklik menu Insert>pilih bagian Interactive Objek> pilih Buttom. 

 

Gambar 2.8. Tampilan memilih objek interaktif 

(e) Membuat tombol berfungsi  

Agar tombol yang dibuat dapat menjalankan fungsi aksi, lakukan dengan 

mengklik ikon tombol, kemudian pilih Trigger > Atur Action > pilih Slide dari 

daftar aksi yang tersedia > dan tentukan tombol tersebut akan berfungsi saat 

tindakan diberikan dengan memilih opsi When dan mengkliknya. 
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. 

 

Gambar 2.9.  Tampilan membuat tombol berfungsi 

(f) Membuat tombol navigasi  

Tombol navigasi adalah tombol yang berfungsi dalam mengoperasikan media 

interaktif yang dibuat. Untuk membuat tombol navigasi daapat memilihmeni 

Insert>Interaktive Media> Maker. Pilihkan icon tombol yanng diinginkan. 

 

Gambar 2.10. Tamppilan membuat tombol navigasi 

(g) Membuat karakter  

Pada software articulate storyline 3 terdapat pilihan karakter yang ingin 

digunakan dalam media. 
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Gambar 2.11. Tampilan membuat menu karakter 

(h) Menambahkan penulisan data diri pengguna media 

Pada saat pengguna daari media ingin mengoperasikan media, kita dapat 

membuat tempaat untuk memasukan daata diri tersebut dengan data entry. 

Pilihlah menu Insert>Interactive Objects>Input>Data Entry.  

 

Gambar 2.12. Tampilan Menambahkan penulisan data diri 

(i) Membuat latihan serta hasil latihan  

Untuk membuat halaman latihan dan hasil latihan, klik Home > Insert > New 

Slide > Graded Question. Lakukan langkah yang sama untuk halaman hasil 

dengan memilih Home > Insert > New Slide > Result. Di bagian ini, tersedia 

berbagai jenis soal yang bisa dibuat, seperti multiple choice, true/false, multiple 

response, fill in the blank, matching drag and drop, matching drop down, dan 

sequence drag and drop. Pilih jenis soal sesuai dengan rencana yang telah dibuat. 

Untuk mengatur hasil latihan, setelah memilih Result > Blender Result Slide, 

tentukan slide yang akan dihitung nilainya melalui pengaturan di bagian Result 

Properties. 

. 



26 

 

 

Gambar 2.13. Tampilan untuk membuat latihan soal 

 

Gambar 2.14. Tampilan untuk membuat hasil latihan  

 

Gambar 2.15. Tampilan Result  Slide Properties 

(j) Menyimpan project 

Setelah megerjakan project, jangan lupa untuk menyimpan project dengan 

mengklik File>Save agar file tersebut mudah diperbaiki jika ada kesalahan 
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(k) Publikasi media pembelajaran interaktif  

Untuk mempublikasikan media interaktif di Articulate Storyline 3, klik ikon 

Publish pada ribbon menu. Hasil publikasi dapat berupa format web yang dapat 

dijalankan melalui browser, LMS, CD, maupun Articulate Online. 

 

Gambar 2.16. Klik icon publish untuk mempublish hasil project 

Setelah selesai membuat media menggunakan Articulate storyline 3 maka bagian 

terakhir yang harus dilakukan adalah mempublikasi media yang telah dibuat supaya bisa 

digunakan sebagai bahan ajar oleh pendidik kemudian didistribusikan ke peserta didik. 

Peneliti dapat menarik kesimpulan bahwasannya Articulate storyline 3 merupakan 

software yang dapat membantu peneliti baik yang pemula maupun yang sudah ahli dalam 

merancang pembelajaran berbasis digital berdasarkan pemahaman yang telah 

dipaparkan. Software ini yang dapat menciptakan media pembelajaran interaktif dengan 

memasukkan beberapa elemen yang mendukung seperti audio, visual, dan audio visual.  

2.1.5 Materi Aljabar 

Dalam Kurikulum Merdeka, materi aljabar umumnya diajarkan pada mata 

pelajaran Matematika kelas VII SMP/MTs semester ganjil, yang termasuk dalam Fase 

D. Pada fase ini, peserta didik mulai dikenalkan dengan konsep-konsep dasar aljabar 

seperti bentuk aljabar, operasi aljabar, serta persamaan linear satu variabel. Namun, di 

SMP Negeri 5 Tasikmalaya, terdapat penyesuaian dalam pelaksanaan pembelajaran, 

yaitu dengan menggunakan sistem blok. Sistem ini memungkinkan penyampaian materi 

dilakukan secara terfokus dalam satu periode waktu tertentu, bukan tersebar secara 

berjenjang seperti biasanya. Dengan pendekatan tersebut, meskipun materi aljabar secara 

nasional dirancang untuk diajarkan di kelas VII, di SMP Negeri 5 Tasikmalaya justru 

diberikan pada kelas IX semester ganjil. Penjadwalan ini disesuaikan dengan strategi 

pembelajaran sekolah serta mempertimbangkan kesiapan dan kebutuhan peserta didik 
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agar proses belajar berlangsung lebih efektif dan bermakna. Meskipun waktu 

penyampaiannya berbeda, materi yang diajarkan tetap mengacu pada capaian 

pembelajaran Kurikulum Merdeka untuk Fase D, sehingga tidak mengurangi kualitas 

maupun kedalaman kompetensi yang harus dicapai peserta didik 

Aljabar adalah salah satu cabang ilmu matematika yang menggunakan simbol 

atau huruf sebagai perwakilan dari bilangan yang belum diketahui. Aljabar umumnya 

melibatkan ekspresi, operasi, penyelesaian sistem persamaan, serta pencarian nilai dari 

variabel yang belum diketahui. (Rahmah & Argaswari, 2020). Kata “Aljabar” berasal 

dari istilah al-Jabr, yaitu salah satu dari dua operasi matematika untuk menyelesaikan 

persamaan kuadrat, yang diperkenalkan dalam buku berjudul al-Kitab al-mukhtasar fi 

hisab al-jabr wa’l-muqabala atau “Buku Ringkasan Perhitungan dengan Melengkapi dan 

Menyeimbangkan,” yang ditulis pada tahun 820 M. Aljabar merupakan perluasan dari 

konsep aritmatika yang melibatkan variabel dan nilai-nilai yang belum diketahui, serta 

digunakan untuk menyelesaikan berbagai masalah matematika. (Permatasari & Harta, 

2018). Permasalahan yang dapat diselesaikan dengan aljabar tidak hanya bersifat abstrak, 

tetapi juga mencakup berbagai masalah di dunia nyata, seperti dalam bidang ekonomi, 

perdagangan, bisnis, sains, dan lain-lain. Bentuk penulisan aljabar merupakan gabungan 

antara koefisien dan variabel. Aljabar umumnya melibatkan penyelesaian sistem 

persamaan, pencarian nilai variabel yang belum diketahui, penerapan rumus kuadrat, 

serta penggunaan rumus, persamaan, dan simbol huruf. Beberapa unsur penting dalam 

aljabar antara lain adalah sebagai berikut.  

(1) Variabel  

Variabel atau peubah adalah suatu lambang yang nilainya belum diketahui sehingga 

dapat diganti dengan bilangan tertentu. Variabel biasanya dilambangkan dengan 

huruf kecil, misalnya 𝑎, 𝑏, 𝑐, 𝑥, 𝑦, 𝑧, 𝑝, atau kombinasinya. Contoh:  

(a) Variabel dari 5𝑥 − 2 adalah 𝑥 

(b) variabel dari 5𝑎 +  𝑏 +  10 adalah 𝑎 dan 𝑏.  

(2) Koefisien 

Koefisien adalah bilangan yang terletak di depan variabel. Koefisien biasa disebut 

sebagai pasangan variabel. Contoh:  

(a) Koefisien 𝑥 dari 5𝑥2𝑦 + 3𝑥 adalah 3 

(b) Koefisien 𝑥2 dari 3𝑥2 + 5 adalah 3  
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Untuk koefisien yang nilainya 1 tidak harus ditulis. Contoh: 1𝑥 +  1𝑦 +  1𝑧 

cukup ditulis 𝑥 +  𝑦 +  𝑧 

(3) Konstanta 

Konstanta adalah nilai tetap dari suatu Bentuk Aljabar yang berupa bilangan dan 

tidak memuat variabel. Konstanta biasa disebut sebagai jomblo karena tidak 

memiliki pasangan variabel disampingnya. Contoh:  

(a) Konstanta dari 2𝑥2𝑦 −  3𝑦 −  7 adalah −7. 

(b) Konstanta dari 3 −  4𝑥2  −  𝑥 adalah 3 

(4) Suku 

Suku adalah setiap nilai atau angka yang dihubungkan oleh tanda + atau – dalam 

sebuah Bentuk Aljabar. Macam-macam suku pada bentuk aljabar antara lain: 

(a) Suku satu (monomial) atau suku tunggal adalah bentuk aljabar yang tidak 

dihubungkan oleh operasi penjumlahan (+) atau pengurangan (−). Contoh: 

3𝑥, 2𝑦2 , dan −2𝑝𝑞 

(b) Suku dua (binomial) adalah bentuk aljabar yang dihubungkan oleh satu operasi 

penjumlahan atau pengurangan. Contoh:  

[1] 2𝑥 − 6   (terdiri dari dari dua suku yaitu 𝑥 dan 3𝑦)  

[2] 𝑎2 + 2𝑏  (terdiri dari dari dua suku yaitu 𝑎2 dan 2𝑏)   

(c) Suku tiga (trinomial) adalah bentuk aljabar yang dihubungkan oleh dua operasi 

penjumlahan atau pengurangan. Contoh: 3𝑥2  +  5𝑦 −  1 

(d) Suku banyak (polinomial) adalah bentuk aljabar yang dihubungkan lebih dari tiga 

operasi penjumlahan atau pengurangan. Contoh:  

[1] 4𝑥2  +  𝑦2  −  𝑥𝑦 −  3    (suku empat) 

[2] 𝑥4  −  3𝑥2𝑦 +  5𝑥2𝑦 +  4𝑥𝑦3  −  4𝑦  (suku lima) 

Dalam bentuk aljabar terdapat suku sejenis dan tidak sejenis. Suku sejenis 

adalah suku-suku yang memuat variabel yang sama dan variabel-variabel tersebut 

memiliki pangkat yang juga sama. Adapun suku tidak sejenis  yaitu jika ketentuan 

memiliki pangkat yang beda. Berikut adalah contohnya:  

(a) Suku Sejenis  

[1] 3𝑥3 dengan 𝑥3  (dikatakan sejenis karena variabel dan pangkatnya sama) 
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[2] 2𝑦2 dengan 3𝑦2  (dikatakan sejenis karena variabel dan pangkatnya sama) 

(b) Suku Tidak Sejenis 

[1] 2𝑦3 dengan 2𝑦2 (dikatakan tidak sejenis karena pangkatnya tidak sama) 

[2] 𝑥2dengan 𝑦2  (dikatakan tidak sejenis karena variabelnya tidak sama) 

Catatan: untuk melihat suku sejenis perhatikan saja variabel dan pangkatnya 

tanpa melihat koefisiennya. 

Selain unsur-unsur aljabar, materi dasar aljabar juga mencakup operasi hitung 

aljabar. Adapun operasi hitung aljabar yang dibahas dalam penelitian ini meliputi: 

(1) Penjumlahan Aljabar 

Operasi penjumlahan aljabar adalah salah satu operasi dasar untuk simbol (+) pada 

bentuk aljabar. Penjumlahan pada bentuk aljabar hanya berlaku pada suku-suku 

sejenis. Berikut sifat-sifat yang berlaku pada operasi penjumlahan aljabar: 

(a) Komutatif   𝑎 + 𝑏 = 𝑏 + 𝑎 

(b) Asosiatif  𝑎 + (𝑏 + 𝑐) = (𝑎 + 𝑏) + 𝑐 

(c) Distributif   𝑎𝑏 + 𝑎𝑐 = 𝑎(𝑏 + 𝑐) = (𝑏 + 𝑐)𝑎 

(2) Pengurangan Aljabar 

Operasi pengurangan aljabar adalah salah satu operasi dasar untuk simbol (−) pada 

bentuk aljabar. Pengurangan pada bentuk aljabar hanya berlaku pada suku-suku 

sejenis. Berikut sifat-sifat distributif pada pengurangan dimana 𝑎, 𝑏, dan 𝑐 

merupakan bilangan riil adalah sebagai berikut: 

(a)  𝑎𝑥(𝑏 − 𝑐) = (𝑏 − 𝑐)𝑎𝑥 = 𝑎𝑏𝑥 − 𝑎𝑐𝑥 

(b) −𝑎𝑥(𝑏 + 𝑐) = (𝑏 + 𝑐)(−𝑎𝑥) = −𝑎𝑏𝑥 − 𝑎𝑐𝑥 

(c) −𝑎𝑥(𝑏 − 𝑐) = (𝑏 − 𝑐)(−𝑎𝑥) = −𝑎𝑏𝑥 + 𝑎𝑐𝑥 

Pada dasarnya penyederhanaan, penjumlahan, dan pengurangan pada bentuk 

aljabar hanya bisa dilakukan pada suku-suku yang sejenis. Oleh sebab itu, sebelum 

menjumlahkan atau mengurangkan, kelompokkan terlebih dahulu suku-suku yang 

sejenis. Setelah itu, jumlahkan atau kurangkan koefisien dari suku-suku sejenis 

tersebut. 
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(3) Perkalian Aljabar 

Sifat yang berlaku pada perkalian aljabar adalah sifat distributif perkalian terhadap 

penjumlahan dan pengurangan. Misal:  

(a) Penjumlahan  : 𝑎 × (𝑏 + 𝑐) = (𝑎 × 𝑏) + (𝑎 × 𝑐) 

(b) Pengurangan  : 𝑎 × (𝑏 − 𝑐) = (𝑎 × 𝑏) − (𝑎 × 𝑐) 

(4) Pembagian Aljabar 

Hasil pembagian bentul aljabar dapat dinyatakan dalam bentuk paling sederhana 

dengan memperhatikan faktor-faktor yang sama. Syarat-syarat operasi pembagian 

bentuk Aljabar:  

a) 
𝑝−𝑞+𝑟+𝑠

𝑥
=

𝑝

𝑥
−

𝑞

𝑥
+

𝑟

𝑥
+

𝑠

𝑥
, dengan 𝑥 ≠ 0 

b) 
𝑝𝑞𝑟

𝑥
=

𝑝

𝑥
𝑞𝑟 = 𝑝 ×

𝑞

𝑥
× 𝑟 = 𝑝𝑞 ×

𝑟

𝑥
, dengan 𝑥 ≠ 0 

c) 
𝑝

𝑥𝑦𝑧
= {(

𝑝

𝑥
) : 𝑦} : 𝑧, dengan 𝑥𝑦𝑧 ≠ 0 

d) 
𝑝𝑎

𝑝𝑏 = 𝑝𝑎−𝑏 , dengan 𝑝 ≠ 0 

e) 𝑝𝑎 =
𝑝𝑎+𝑥

𝑝𝑥  

2.1.6 Model Flipped classroom 

Flipped classroom adalah pendekatan pembelajaran yang membalikan metode 

tradisional. Pada model ini, peserta didik mempelajari materi pelajaran secara mandiri di 

luar kelas, biasanya melalui video, modul interaktif, atau bahan bacaan yang diberikan 

oleh pendidik. Ketika di dalam kelas, waktu pembelajaran digunakan untuk diskusi, 

penyelesaian masalah, atau aktivitas kolaboratif yang lebih mendalam. Flipped 

classroom adalah model penyampaian pembelajaran yang mengalihkan kegiatan 

penyampaian materi yang seharusnya dilakukan di kelas menjadi kegiatan di rumah, dan 

mengalihkan pekerjaan rumah yang awalnya merupakan kegiatan di rumah menjadi 

serangkaian kegiatan berpikir kritis yang dilakukan di kelas (Brown dalam Ismaniati, 

2023). Flipped classroom adalah strategi pembelajaran yang mengadopsi pendekatan 

pembelajaran campuran (blended learning) dengan membalikkan cara belajar 

konvensional, di mana materi pembelajaran disampaikan di luar kelas terlebih 

dahulu.(Susanti & Pirta, 2019).  
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Terdapat empat pilar utama yang harus diterapkan pendidik dalam pembelajaran 

kelas terbalik menurut Nurpianti et al., (Yulianti & Wulandari, 2021), yaitu sebagai 

berikut.  

(1) Pendidik memberikan kesempatan kepada peserta didik untuk berinteraksi dan 

merefleksikan hasil pembelajarannya dalam lingkungan yang fleksibel (Flexible 

Environment). 

(2) Peserta didik diberikan kebebasan penuh sebagai pusat dalam proses pembelajaran 

(Learning Culture Shift). Pada aspek ini, pendidik menyediakan materi pembelajaran 

yang dapat diakses oleh peserta didik kapan saja dan di mana saja (Intentional 

Content), serta selalu siap membantu peserta didik secara individual, kelompok kecil, 

maupun secara keseluruhan selama waktu di kelas. 

(3) Melakukan penilaian formatif selama proses pembelajaran berlangsung dengan 

observasi dan pencatatan data yang dapat digunakan untuk perbaikan instruksi di 

masa mendatang. 

(4) Bertanggung jawab untuk melakukan inovasi dan perubahan sebagai pendidik 

profesional (Professional Educators). 

Model flipped classroom adalah pendekatan pembelajaran di mana urutan 

pemberian materi dan tugas dibalik, yaitu materi dipelajari di rumah, sedangkan tugas 

atau latihan dikerjakan di sekolah. (Listianti & Rahim 2022). Dalam metode 

pembelajaran tradisional, peserta didik menerima pengajaran langsung dari pendidik di 

kelas melalui ceramah, diskusi kelompok, atau kegiatan membaca dan mengamati, 

kemudian melaksanakan tugas penguatan di rumah seperti mengerjakan pekerjaan rumah 

(PR), merangkum materi, atau membuat kliping. Namun, dalam model flipped 

classroom, materi pembelajaran terlebih dahulu disampaikan lewat video atau presentasi 

PowerPoint yang harus dipelajari oleh peserta didik di luar kelas. Selanjutnya, mereka 

membuat rangkuman, mencatat poin penting, menyusun pertanyaan, berdiskusi, atau 

mencari sumber tambahan yang diperlukan. 

Terdapat beberapa langkah dalam pembelajaran dengan menggunakan model 

flipped classroom. Berikut langkah langkah pembelajaran flipped classroom menurut  

Steele (dalam Riska et al., 2024)  
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Gambar 2.17. Langkah pembelajaran flipped classroom menurut Steele 

(1) Peserta didik diminta untuk menonton video pembelajaran atau media lain di rumah 

sebagai persiapan sebelum mengikuti kegiatan pembelajaran di kelas (preclass). 

(2) Peserta didik hadir di kelas untuk melaksanakan pembelajaran dengan mengerjakan 

tugas yang berkaitan dengan materi yang telah dipelajari sebelumnya. 

(3) Peserta didik mengaplikasikan kemampuan mereka melalui proyek atau simulasi 

lainnya di dalam kelas. 

(4) Tahap terakhir adalah evaluasi pemahaman peserta didik terhadap materi yang telah 

diajarkan. 

Berdasarkan hasil analisis dan sintesis, dapat disimpulkan bahwa model 

pembelajaran flipped classroom merupakan perpaduan antara pembelajaran di dalam dan 

di luar kelas. Saat berada di luar kelas, peserta didik lebih fokus mempelajari materi yang 

telah disiapkan oleh pendidik melalui media pembelajaran. Sedangkan di dalam kelas, 

peserta didik mengembangkan pengetahuan yang telah dipelajari sebelumnya melalui 

aktivitas seperti diskusi, pemecahan masalah, proyek, dan kegiatan lainnya. 

Model flipped classroom memiliki kelebihan dan kekurangan. Adapun kelebihan 

model flipped classroom menurut Nicola Sales (dalam Alfina, Harahap, & Elidra, 2021) 

adalah sebagai berikut.  

(1) Peserta didik memiliki kendali atas proses belajarnya sendiri dan turut bertanggung 

jawab terhadap hasil belajarnya. 

(2) Video pembelajaran yang diberikan sebelum kegiatan tatap muka memungkinkan 

peserta didik untuk belajar secara fleksibel, tanpa terikat oleh waktu dan tempat. 

Mereka dapat menentukan sendiri seberapa banyak materi yang ingin mereka pelajari 

sesuai kebutuhan. 
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(3) Dengan memiliki pemahaman awal terhadap materi, peserta didik dapat memprediksi 

capaian belajar yang mungkin mereka raih saat pembelajaran berlangsung di kelas. 

(4) Model pembelajaran flipped classroom mendorong keterlibatan aktif peserta didik 

selama proses belajar berlangsung. 

(5) Interaksi belajar meningkat, baik antar peserta didik dalam satu kelompok, antar 

kelompok, maupun interaksi antara peserta didik dan pendidik. 

(6) Kegiatan pembelajaran praktik yang biasanya sulit dilakukan di kelas kini dapat 

terlaksana dengan pendampingan langsung dari pendidik. 

Selain kelebihan yang disebutkan, terdapat kekurangan model flipped classroom 

menurut Natali (dalam Alfina et al., 2021) yaitu: 

(1) Kualitas video yang digunakan dalam pembelajaran terkadang tidak memadai. 

(2) Karena peserta didik menonton video pembelajaran secara mandiri di perangkat 

masing-masing, ada kemungkinan suasana belajar kurang kondusif dan pembelajaran 

menjadi kurang optimal. 

(3) Ada kalanya peserta didik tidak menonton atau tidak memahami isi video, sehingga 

mereka datang ke kelas tanpa persiapan yang cukup untuk mengikuti kegiatan 

pembelajaran tatap muka. 

(4) Sebagian peserta didik mungkin memerlukan bimbingan tambahan untuk memahami 

materi yang disampaikan melalui video. 

(5) Saat hanya menonton video secara mandiri, peserta didik tidak memiliki kesempatan 

untuk bertanya langsung kepada guru atau berdiskusi dengan teman sekelas. 

2.2 Hasil Penelitian yang Relevan 

Pengembangan media pembelajaran menggunakan Interaktif dengan Articulate 

storyline 3 pernah dilakukan oleh Adam & Mulyani (2023) melalui model Bord and Gall. 

Hasil dari penelitian tersebut menyimpulkan bahwa media pembelajaran interaktif 

dengan Articulate storyline 3 dapat digunakan pada perangkat Android maupun laptop, 

media yang dikembangkan berada pada kategori sangat layak dan dapat diujicobakan 

kepada peserta didik. Penelitian yang akan dilakukan adalah mengembangkan media 

pembelajaran interaktif dengan software yang serupa tetapi menggunakan model 

pengembangan ADDIE.  
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Pengembangan media pembelajaran interaktif berbasis Android pernah 

dikembangkan menggunakan I-Spring dan APK Builder oleh Handayani & Rahayu 

(2020). Hasil penelitian yang telah dilakukan menunjukkan bahwa media pembelajaran 

interaktif berbasis Android menggunakan I-Spring dan APK Builder sangat layak 

digunakan. Penelitan yang diangkat yaitu mengembangkan media pembelajaran iteraktif 

yang serupa yaitu berbasis Android tetapi dengan software Articulate storyline 3 

menggunakan model pengembangan ADDIE.  

Pengembangan media pembelajaran berbasis Android menggunakan Articulate 

storyline 3 pernah dikembangkan oleh Rizky, Wijayanti, & Faulina (2023) pada materi 

Trigonometri. Hasil penelitian yang telah dilakukan menunjukkan bahwa pengembangan 

media pembelajaran Artciulate Storyline 3 pada materi trigonometri dinyatakan sangat 

efektif berdasarkan persentase keberhasilan hasil belajar peserta didik. Penelitian yang 

dingkat yaitu mengembangan media yang serupa pada materi aljabar menggunakan 

model ADDIE.  

Pengembangan media pembelajaran interaktif menggunakan Articulate storyline 

3  berbasis saintifik pernah dikembangkan oleh  Anggraini & Reinita (2022). Berbasis 

disini maksudnya adalah bahwa media tersebut didasarkan pada pendekatan saintifik, 

yang mengutamakan proses ilmiah dalam pembelajaran. Dalam hal ini, kata berbasis 

serupa dengan kata memfasilitasi, karena keduanya berfungsi untuk menyediakan sarana 

atau landasan yang mendukung terjadinya proses pembelajaran yang efektif. Hasil 

penelitian ini menyatakan bahwa penggunaan media pembelajaran Articulate storyline 3 

berbasis saintifik memperoleh kategori valid dan dinyatakan sangat praktis. Penelitian 

yang akan dilakukan bertujuan untuk mengembangkan media interaktif menggunakan 

software serupa yang dapat memfasilitasi model pembelajaran flipped classroom, 

sehingga mendukung pembelajaran lebih aktif dan mandiri bagi peserta didik. 

Pengembangan media yang digunakan untuk materi aljabar pernah dilakukan 

oleh Samudro, Shodikin, & Aini (2022) menggunakan Ispring Suite 10; Dewi & Izzati 

(2020) menggunakan Power Point dan Prayitno, Taufik, & Muawanah (2022) 

menggunakan Adobe Flash. Hasil penelitian menunjukan bahwa media pembelajaran 

yang dikembangkan berhasil mencapai tingkat validitas dan praktikalitas yang sangat 

baik. Penelitian yang akan dilakukan yaitu mengembangkan media pada materi yang 

sama tetapi menggunakan Articulate storyline 3. 
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2.3 Kerangka Teoretis 

Pada tahap pra-penelitian, ditemukan beberapa kendala yang dihadapi oleh 

peserta didik, salah satunya adalah penyampaian materi yang masih berpusat pada 

pendidik (teacher-centered), yang menyebabkan peran aktif peserta didik kurang 

optimal. Media yang digunakan pun terbatas pada buku paket. Khususnya pada materi 

aljabar, peserta didik kurang terlibat dalam pembelajaran secara aktif. Akibatnya, 

pembelajaran terasa monoton dan kurang memotivasi peserta didik untuk berpartisipasi 

secara maksimal. 

Pada penelitian ini, peneliti akan mengembangkan media pembelajaran interaktif 

menurut Handayani & Rahayu (2020). Media pembelajaran interaktif yang 

dikembangkan oleh peneliti ini berbasis Android karena penggunaannya yang fleksibel, 

dapat diakses kapan saja dan dimana saja (Kuswanto & Radiansah, 2018). Media ini 

memanfaatkan perangkat lunak Articulate storyline 3 sebagai platform  untuk 

pengembangan materi pembelajaran. Articulate storyline 3 dipilih karena 

kemampuannya dalam membuat konten interaktif dengan elemen multimedia yang 

menarik dan mudah dioperasikan (Sinambela, Simanjorang, Manurung, & Simanullang, 

2022).  

Pengembangan media pembelajaran ini mengacu pada model pengembangan 

ADDIE (Analysis, Design, Development, Implementation, Evaluation) yang diadopsi 

dari  Branch (2009). Model ini dipilih karena memberikan tahapan yang sistematis dalam 

merancang media pembelajaran. Pada tahap analisis, dilakukan identifikasi kebutuhan 

pembelajaran peserta didik dan permasalahan utama. Tahap desain mencakup 

penyusunan blueprint media pembelajaran, termasuk alur penyajian materi dengan 

mengikuti langkah-langkah model pembelajaran Flipped classroom. Pada tahap 

pengembangan, media dirancang menggunakan Articulate storyline 3, dengan integrasi 

elemen visual, audio, dan interaktivitas. Tahap implementasi melibatkan uji coba terbatas 

dengan peserta didik, diikuti oleh evaluasi untuk memastikan kelayakan dan efektivitas 

media. Tujuan pengembangan media tersebut yaitu untuk membantu peserta didik 

memahami konsep-konsep matematika secara mandiri sebelum pertemuan kelas. Media 

ini dilengkapi dengan konten materi, evaluasi, serta aktivitas interaktif yang dirancang 

khusus untuk mendukung model pembelajaran flipped classroom, seperti yang dijelaskan 

oleh Stelee (dalam Riska et al. 2024).  
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Proses pengembangan media yang dilakukan oleh peneliti ini digambarkan secara 

terstruktur dalam kerangka teoritis berikut.  

 

Bagan 2.1 Kerangka Teoritis. 

2.4 Fokus Penelitian 

Fokus penelitian adalah penekanan pada sudut yang lebih luas dan lebih 

mendalam (Gumilang, 2016). Fokus penelitian ini adalah pada pengembangan media 

pembelajaran interaktif berbasis Android menggunakan articulate storyline 3 yang 

dirancang khusus untuk materi aljabar. Media ini ditujukan untuk memfasilitasi 

pembelajaran yang menggunakan model flipped classroom, sehingga peserta didik dapat 

memahami konsep aljabar secara lebih efektif, baik melalui pembelajaran mandiri 

maupun interaksi di kelas. Pengujian produk dilakukan pada peserta didik kelas IX di 

SMP Negeri 5 Tasikmalaya. 


